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A
by John G. Hendron

ccording to an online article by web usability expert Jakob Nielsen,
�Hopefully, schools will soon begin teaching kids how to author hypertext
and build good Web content. The ability to communicate online will be a

key job skill in the new economy and also an important mechanism for self-
actualization.� (Nielsen, 2000, ultimate section, Para. 1)

Since the mid-1990s, new tools have emerged to help assist users (young or
not) in generating �good design� or �good HTML� in place of actually using the lingua
franca of the web: Hyper Text Markup Language. Examples include products from
Radio UserLand, Clement Mok�s Net Objects, and, of course, visual hypertext
editors including Macromedia Dreamweaver, Microsoft Front Page, and even
Microsoft Office applications.

The power of today�s Internet and related technologies easily offers
publishing ability to students and teachers. Cell phones that can take photographs
and PDAs that can perform wireless exchanges of pictures and text are just the
beginning of what shall come. It should not be difficult within the next five years to
take a short movie with such a device and upload it to a website without the use of
a PC in the entire publication process.

In a recent article, Nielsen draws a comparison between the world of
technology and the world of Harry Potter: �...In the Harry Potter books, the
population consists of two distinct groups � a small group of wizards, and a much
larger group of Muggles (standard-issue humans) who know nothing about magic or
the dealings of wizards.� (Nielsen, 2002, ultimate section, Para. 1) With the tools
becoming available to easily publish material online, one might say that teachers and
students (the Muggles) are being offered the chance to dabble in wizard�s magic.

Nielsen�s hope in educating children about hypertext is somewhat self-serving
as a usability expert:

If we reach children while they are young, they are more likely to be better than
most adults today at creating their own Web content. Although most may never
be great, many will be able to produce good content that will appeal to small
audiences. Perhaps most importantly, a few will emerge who not only exploit
the possibilities of content creation, but push it to new levels. (Nielsen, 2000,
ultimate section, Para. 3)

Without Web usability, however, both organizations and users suffer
throughout the Web experience.

Educators as
Content Publishers
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This article outlines the benefits of teacher publication in hypertext on the
Web and one method or framework that can be used to achieve this. The rationale
behind this can also be easily applied to student learning through their participation
as content authors.  Educators who often feel like Muggles in an ever-advancing
world of �techno� magic will hopefully find a solution to the challenges they face.

What does a good Web site involve? Design and layout receive a lot of
attention in books and in Web sites that give pointers in HTML, CSS, Javascript, and
many of the other technologies that many teachers have no time whatsoever to
learn. And while a good, accessible design is important, the content within Web
pages is the most valuable asset of a site. What would happen if the process were
distilled so that Web authors could work only with content?

One quickly learns an important lesson about Web usability: users do not like
to read online. This will likely evolve over time, but instead of reading word by
word in Web documents, most people tend to scan and skim. Instead of large
paragraphs and a lot of text (at hard to read font-sizes and low resolutions),
readers generally prefer shorter paragraphs, highlighted terms and concepts in
bold face, and bulleted lists when they�re appropriate. It also turns out that Web
users do not like to scroll a lot (never horizontally) and links at the end of sentences
make the most sense.

Headings help a person scan the page for its major elements. Writing for the
Web, therefore, is different than writing for a newspaper, an academic journal, or a
paper in school. While some of these types of writings might be found on the Web,
by themselves they serve as poor examples of how to write for an audience
whose primary reading accessory is the mouse (For further reading on good writing
for the Web, see Hot Text: Web Writing that Works, by Price & Price, 2002).

For writing in such a way that is brief and to the point, the author might also like
to link to other things on the Web. After all, providing links that relate to the topic at
hand helps establish credibility. This is all part of being a good communicator. So
what is the secret ingredient? The weblog. The Wizards of the Web are calling them
blogs nowadays, and it is a genre unique to cyberspace.

A blog is an online compilation of entries, not unlike a diary. While some blogs
on the Web are very personal in nature, others are related to specific subjects. In a
given sitting, you may peruse a weblog on Mac OS X hints, or one focused on
opening a new restaurant or another centered upon obscure and sensational news
stories (�Man gets $28 ticket for leaving headlights on� and the like). What blog
authors put in their blog is left to their own choosing, but the format is usually
organized in the form of entries, sorted by date and sometimes category.

What makes blogging possible is database connectivity. A person need only
design a web page once and never has to redesign the page again.  Weblog entries
are entered into a database which regenerates the content in reverse-
chronological order and posts it all on the World Wide Web. Examples of
companies or tools available to create a blog include Blogger, Movable Type,
Greymatter, Radio Userland, b2. The list is always expanding. Some of these
products are free, while others can be purchased. Some applications must be
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installed on a computer, whereas others simply need to be configured. A search
on Google or another web-based search engine is an easy way to get started
(There are links to some recommended blog resources at the end of this article,
however).

Alan November has said that he believes every teacher should have a
homepage (November, 2002). In a recent article from his Web site, he draws a
distinction between automating with technology and informating.

You get very different results when you informate. The real revolution is
information and communication, not technology. Let go of the word technology.
If you focus on it, then you�ll just do what you�re already doing. The trick in
planning as we move forward is to think about information systems, whole
systems of the flow of information and communication. (November, 1998)

He also calls for the need for teachers to share what they do:
Teachers don�t know how special they are. They wouldn�t know because they
don�t have a collective sense. So one of the things we absolutely need to do if
we are really going to support standards is build capacity so there is a collective
knowledge and wisdom (November, 1998, section 3, Para. 2).

Blogging is one method towards sharing, informating, or just plain
communicating and its ease-of-use compares with sending electronic mail. Teachers
can use this Web publishing medium to easily share information for students, create
links to websites for assignments, present their best practices and their lesson plans,
show-off the fruits of their students� work, post digital pictures, and more.

The blog does several things to assist teachers in becoming good publishers
to the Web. First, it promotes frequent entries. By updating the web page or site
frequently, people are more often encouraged to visit and read what one has to
say. Second, the blog promotes short, succinct entries. Teachers can provide
either a few sentences or maybe a list. If a blog author has something longer or
more formal to say, the text can be attached as a link. Third, blogs encourage the
use of headings for each entry. Headings help users scan a web page for what is
useful to them. Educators may publish content for students, parents, and other
teachers. The multiple audiences can quickly read text they want to read if the blog
design encourages fast scanning.

Fourth, weblogs put emphasis on content and not on Web design. Special
training on HTML or a software editor like Microsoft�s FrontPage is not required. In
fact, someone else can design the page, and many blog products come with pre-
designed pages for those with neither the time nor inclination to learn Web design
skills. Recall that despite all the elaborate and animated graphics that can be seen
on the Web today, it is the content that really counts. Finally, a blog encourages
discussion about material available online. While some may resist screen-based
material over printed materials, the Web offers many advantages. The ability to
place links about material found elsewhere on the Web (hypertext) makes finding
relevant material easy. The number of weblog tools that enable visitors to a web
page to post comments is ample evidence of the interactivity the Web promotes.
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While some may be looking for other reasons why teachers should publish,
other incentives prevail: the stimulation of the publication process for students.
Students can use blogging in a variety of ways, and publication of student entries
can be controlled on a closed-network server (intranet) to protect both students
and a school. Expectations are raised when students have a teacher-generated
model for publication on the Web. It will be the students, no doubt, who will �push
[Web publishing] to new levels� (Nielsen, 2000).

This integration of technology takes advantage of new and emerging
standards that take access to the Internet to a new level. Ultimately, by creating
content through the genre or facade of a blog, teachers help fellow educators by
sharing content and engaging students and their families through the Web medium.

Blogger - www.blogger.com
Blosxom - www.raelity.org/apps/blosxom/
Greymatter - www.noahgrey.com/greysoft/
Movable Type - www.movabletype.org
Radio Userland - radio.userland.com
SnipSnap - snipsnap.org/space/start

Weblogs.com - www.weblogs.com

� Doctorow, C., Johnson, J.S., Trott, M.G., Trott, B.,  & Dornfest, R. (2002). Essential
Blogging.

� Price, J. & Price., L. (2002). Hot Text: Web Writing that Works.

� Bausch, P., Haughey, M., and Hourihan, M. (2002). We Blog: Publishing Online with
Weblogs.

� Nielsen, J. (2000). Content creation for average people. Jakob Nielsen�s
Alertbox. Retrieved January 2, 2003, from http://www.useit.com/alertbox/
20001001.html
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by Vivian Griese

So What Do You Think?

hinking is a skill that is in great demand in our modern society. Employability
studies document the need for a future work force capable of a more
sophisticated way of thinking than generally required in the past.  Skills such as

independent analysis, flexible thinking and collaborative problem solving are now
considered basic requirements for many jobs (Costa, 1991).  The arts are a natural
avenue for developing these skills, but many consider the arts as �insignificant� or
�extras� in the curriculum.  With today�s advances in technology, the arts have been
successful in adapting these new media in the classroom.  One only needs to
observe the explosion of 2D and 3D animation movies as well as the wide range of
video and computer games that are readily available.  Many artists have found a
successful niche in this computer driven industry.

Hampton City Schools, where this author teaches, has made a commitment
to integrating technology in all areas and improving the work force for area
industries.  The partnership between the schools and the business community is
working towards developing a work force that meets the need for higher order
thinking.

The arts have been an active partner in this area as well.  All four of the city�s
high schools teach three levels of 3D Animation.  Each high school has a computer
lab with Macintosh G4�s capable of supporting the animation program, LightWave
3D by NewTek.  This is an advanced animating program used by many professional
media industries.

Students usually sign up for 3D Animation because it sounds like a fun and easy
class.  The computer does not seem as intimidating as a blank sheet of paper and a
pencil, so students who feel they lack traditional studio art skills are drawn to this
class as well.  However, once they get into class they realize that this class isn�t
ordinary.  The class is still fun, but it demands that the student spend time thinking
before working.

So how does a fun 3D Animation class promote this concept of higher order
thinking?

Beyond the Fun:
Three Dimensions
of 3-D Animation
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Spring 2003 Vol. 17, No. 3  8

www.vste.org

3-D Animation, continued

First the process of creating an animation using the LightWave 3D program
should be explained.  The software is actually divided into two programs.  Modeler
is the program that allows the student to create objects.  These objects are like the
actors in a play.

The objects are then imported into the second program, called Layout.  It is
in Layout that simple and complex movements, special effects, textures, lighting and
camera angles are manipulated.  This arena is like the stage in an auditorium, where
the actors created in Modeler will perform.  This stage is based on the
mathematical concepts of the X, Y, and Z-axes.  The center of this universe is the
point where these three axes meet, called 0, 0, and 0.  All objects move around
these axes, in either positive or negative placements.

Students are the directors of their own plays. They determine actors (the
objects) and what parts they will play in the production (layout). The students must
visualize all aspects of this production before beginning the first stage of modeling.
So students are required to sit and think through an animation from beginning to
end, deciding on particular special effects, movements, lighting moods, etc.  The
student then works backwards from the end product to the part where the object
must now be modeled.

Even before modeling the object, the student must first visualize the
completed object.  Then the student condenses the object down to a few basic
shapes (oval, circle, square, triangle, rectangle or cone).  From these simple basic
shapes, which the computer helps create, the student begins to shape this very
basic object, manipulating it to his final visualization.  This process is similar to
modeling a 3D sculpture out of marble or clay.  Artists will first clear away the
excess and start with some basic shapes, then manipulate the material until the
details become clear.  Obviously, the more detail a student applies to the object,
the more realistic and believable it will look.

Students will often model a very simplistic object but describe it as if the
object contains all the detailed elements.  This ability to visualize and create detail
often takes time to develop.  However, this is a very important step in promoting
higher order thinking.

In addition, these students must develop the skill to mentally visualize, or think,
through an entire process, then backtrack their thinking to make sure the object
modeled will perform all the tasks required, once it is moved into layout.  This is an
extremely complicated task for a student to master, but once the student has, the
animation becomes much easier to create and the results are dynamic.  Because
students constantly build on their skills through each subsequent animation, the
constant repetition of tasks increases their ability to think through an animation more
quickly and clearly.
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This requirement of thought in creating a 3D-animation project includes the
four basic components for facilitating higher-level thinking skills, which are:
� Students are better able to organize the way in which specific

thinking processes are engaged.
� Significant opportunities exist for the student to reflect on the thinking they

are doing.
� Opportunities exist for the student to practice doing the same sort of

thinking in new situations.
� Opportunities exist for collaboration between students in which good

thinking attitudes are modeled (Costa, 1991).

Creating an animation forces the student to engage in the following complex
thinking processes as well:

Problem SolvingProblem SolvingProblem SolvingProblem SolvingProblem Solving
A project is assigned and the student must decide how to solve the

�problem� of the assignment.  An example is the �Enclosed Space� assignment.  The
parameters say that it can be any kind of enclosed space, but does not have to be
a building; it could be a book bag, file cabinet, etc.  The enclosed space must have
at lease one opening where the viewer is able to look outside of the enclosed
space.  There must be three major objects (to be modeled realistically and
accurately and play major roles in the animation) and five supporting objects (which
do not have to have a high degree of realism, but must be modeled believably).
With these parameters, the student must decide and problem-solve how these
goals will be achieved.  How an object is to move must first be determined before
it can be modeled.  Modeling determines what kind of movements an object can
make.

Decision MakingDecision MakingDecision MakingDecision MakingDecision Making
The student compares advantages and disadvantages of alternative

approaches to solving the animation problem.  In addition, the student must always
keep in mind whether the modeling will take longer than the allotted time for the
assignment and whether all the objects work well together in the final animation.

Critical ThinkingCritical ThinkingCritical ThinkingCritical ThinkingCritical Thinking
This process of developing a cohesive and logical reasoning for the animation

and then bringing it to a credible and convincing solution is difficult for the student
to focus on.  It is more fun to begin modeling the objects rather than think through
to the end product.  However, the successful students are able to keep this vision
in focus.

Creative ThinkingCreative ThinkingCreative ThinkingCreative ThinkingCreative Thinking
Students are always encouraged to think of the unusual or novel solution to

the animation problem.  Thinking beyond what first pops into the mind and planning
a unique twist to the plot is crucial to making the animation interesting to watch.

As one can see, this is a crash course for many students in stretching some
thinking muscles they didn�t know they had.  However, whether they want to or not,
the immediate gratification of the animation process keeps the students striving to
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learn and progress in the class.  The side benefit is the development of higher order
thinking skills, which seems to transfer for some students into other classes.  This
�fun� class actually has a hidden agenda in turning my students into mature thinkers!

Can You See It?
One of the most difficult components of modeling an object in 3D animation

is the ability to mentally visualize the object to be created.  In limited cases, an
actual model can be used, allowing the student to actively touch and observe what
needs to be modeled.  However, with the endless number of objects that a
student has to choose from to create, it is impossible to have a physical example
of every object.  Students must then rely on their ability to make mental images.

Reducing an object down to basic forms, manipulating the form to create a
more realistic version, then finally adding the �extras� that make the object
convincing is a visual imaging process, often called a visual-spatial ability.

Hand in hand with this ability to mentally visualize an object is the ability to
place it in a spatial context. Spatial intelligence is closely tied to and grows out of
one�s observation of the visual world.  However, spatial intelligence is not always
dependent on the visual sense (Gardner, 1983).  Spatial ability is a general capacity
to imagine objects in different perspectives (McGuinness, 1979).

Where does the object reside in space in relation to other objects?  How do
these objects react to each other and are they in proportion to each other?  This
spatial acuity does not always come easily to students.  It is a skill that must be
learned and repeated often.  The nature of 3D animation forces the student to
constantly make decisions of relationships between objects.  These relationships
grow from simple size problems in Modeler to more complicated visual elements
in Layout (where the objects actually move around and interact with each other).
Making estimations, trial and error, and finally corrections are integral to perceiving
correctly.  Studies have shown that there is clearly an important connection
between movement and spatial ability.  What isn�t known is how this works.
(McGuinness, 1979)

3D Animation as an exercise in spatial intelligence draws together a variety of
loosely related capacities.  The ability to recognize instances of the same element;
the ability to transform one element into another; the capacity to conjure up mental
imagery and then transform that imagery; the capacity to produce a graphic likeness
of spatial information; and the ability to move and twist viewpoints of an element
are valuable skills the animator is repeatedly practicing (Gardner, 1983).

Spatial ability has also been linked to aptitude in higher mathematics
(McGuinness, 1979).  Spatial tasks are problems involving imagery in three
dimensions, rather than two dimensions (which would be paper and pencil
examples).  The capacity to visualize the relationship between the motion of one�s
body and elements or objects in the world makes it possible to frame space in
terms of geometric coordinates (Layout�s xyz coordinates).  This leads to the ability
to construct mental maps of unfamiliar territories.  The speed in which a spatial
problem is solved, as in the case of animation, is dependent on the capacity to
visualize motion in the 3D environment.
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Math has been defined as the science of quantity and space.  Quantity and
space refer initially to objects and object relations in the world.  When students
begin imaging in a three-dimensional space, they begin to place that object around
an axis. All movements in LightWave are based on the interaction of other objects
within the field of xyz and the positive and negative coordinates relating to the axes.
These areas of problem solving for the student are obviously math related.
However, the student is having too much fun watching his objects spin through
space to realize he is learning higher-level math concepts.

Some students have mentioned that they seem to find their math and some
aspects of science easier to comprehend after being in animation for at least two
years.  Even though there are no formalized studies, it could be that the repeated
use of the LightWave universe has provided the students with repetitive concrete
applications of the math concepts.

Another observation in relation to spatial acuity that bears studying is the
improvement of some students who have visual processing disabilities.  One
student, who had trouble with complex abstract thinking and problem solving skills
as well as spatial difficulties, spent two years in my animation class.  He continually
improved in his ability to think through an assignment and create an animation by
being deliberate in his actions, rather than allowing �happy accidents� to occur for
him.  This student also had spatial difficulties that required his teachers to bubble in
the circles on tests that were routinely given.  He was unable to accurately darken
within the lines.  However, after two years in animation, he became able to perform
that task himself without aid.  The teacher could not explain any other reason for his
ability to begin performing this task, other than taking animation.  Without additional
studies one cannot say with certainty, but clearly the evidence is there that
repeated visual and spatial problem solving over the course of two years made an
impact on this student.

Getting Motivated
The last important area is not defined by any scientific studies, but rather

direct conversations with animation students.  Many students signed up for the first
animation class because it sounded like fun, but they never seriously thought of this
class as a stepping-stone out of high school and into a career.  These students
would have laughed at anyone suggesting they attend college.

However, some students have become very successful in animating and
found that they have a �knack� for modeling objects, visualizing action and putting it
all together.  They enjoy the challenge of the animation problem and the ability to
sharpen their computer skills.  It is exciting to see them start to dream of a career,
especially one that they will love doing.

This author has had the pleasure of watching students enter an animation class
with no direction or thought of what they might do after graduation.  Then after two
or three years in these classes, they begin to seek out colleges where they can
continue their education.  What a feeling of satisfaction knowing that this �fun� class
impacted a student�s future.

http://www.vste.org


Spring 2003 Vol. 17, No. 3  12

www.vste.org

3-D Animation, continued

Thanks to technology, thanks to artists willing to use technology as a tool for
creativity, thanks to school districts with vision and thanks to students who take a
chance on a new class, lives have been profoundly impacted.  This is what
education is all about, motivating students, helping students learn about themselves
and a skill they can be good at, getting them to think the �big picture� and find a
career that they will love.  3D Animation � beyond the fun and into the future!
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The Technology
Game: Perspectives
and Reflections on
School-based
Technology Training
Specialist Support (Part I)

EditorEditorEditorEditorEditor�s note:�s note:�s note:�s note:�s note: In this first article of a two-part series, the author begins to answer
the question, �How can a school-based technology training specialist (SBTS, also
known as a Technology Resource Teacher) support classroom teachers and
specialists as they learn to integrate technology  into their classroom curriculum?
The second part of Bryan�s article will appear in the next issue of the VSTE
Journal.

Playing the Game
ave you ever played a game such as Monopoly in which the favorable or
unfavorable card draw determines whether you win or lose the game?
Although practice and experience increase your skills, circumstances

beyond your control influence the game�s outcome.  Skill alone can�t insure a win.
A sequence of poor draws discourages you from playing again.  Beneficial draws
make you a winner and eager to play the next game.  Your resulting energy is high
and you can�t wait for the next opportunity to try your luck.

The process by which technology is integrated into classroom curriculum
throughout Fairfax County (and I suspect in other counties across our country)  is
being played in a manner similar to a board game.  Each day teachers encounter
circumstances that either encourage or discourage the integration of technology
into lesson plans and curriculum objectives.  When teachers draw favorable cards,
their integrated plans are implemented, their students find appropriate on-line
resources, or create new knowledge and communicate in unique ways.  Teachers
are encouraged to use technology in future lessons.  When those same teachers
draw unfavorable cards, they might not be aware of appropriate software available
to them, might feel too insecure to implement new programs, their schedules might
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The Technology Game, continued

be interrupted, or their computers might freeze.  Their momentum is stopped, their
projects are delayed or destroyed, and their desire to play The Technology Game
dissolves.

Not a matter of Chance
The Technology Game is not a game of chance.  It is a very serious

commitment to the future of our students.  There are prerequisites to success:

� Before teachers can use technology consistently in their lesson plans and
curriculum objectives, they need assurance of easy assess to working
hardware and appropriate software programs.

� Having technology available does not insure appropriate use.   The power
of school technology can only be realized when teachers are trained and
motivated to use the available equipment. Teachers are motivated to use
technology, even if it requires a change in teaching strategies, if they are
aware of the importance of technology to their students.  Modeling by
SBTS or Technology Resource Teachers offers opportunities for teachers
to see these advantages.

� Teachers are more willing to attend training if they anticipate immediate
classroom use of applications. When workshops are planned around
teacher requests and curriculum needs, they are well received and are
more likely to be used by teachers in subsequent lessons.

� The SBTS or Technology Resource Teachers is in a unique position to help
teachers integrate technology into their classroom curriculum.  They can
design activities that will be responsive to teacher requests.  They can be
proactive and initiate activities to train and motivate teachers as they
struggle to integrate technology.  They can encourage teachers to take
risks in using technology.  Collaboration between two experts, initiated by
SBTS is a critical way that we can support teachers.

While The Technology Game is being played across Fairfax County and other
counties everyday, the future of our students� literacy skills is hanging in the balance.
By �literacy� I mean the ability to acquire and express information in a variety of
electronic media as well as through the traditional print media.  To successfully
complete this game, teachers must recognize the importance of technology
integration and appreciate new teaching strategies that support the changing
literacy needs of students. The final goal of the technology game is to create a
learning environment in which student achievement is accelerated through the
integration of technology in classroom curriculum.    This learning environment must
provide the tools of knowledge acquisition and communication for the 21st
century and must develop the skills required to utilize these tools.  The question is:
� Are we winning this game?�

As the full time School-Based Technology Training Specialist (SBTS) at Lemon
Road, a small elementary school, my role in this game seems clear.  It is my job to
clarify the rules of the game, to identify the objectives and to help teachers and
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students realize our goals.  It is my job to see that the teachers receive more
positive, advancement cards than they do negative, regressive cards as they face
the challenges of technology integration.   I must be a proactive leader who shares
a vision of technology integration and who collaborates with teachers to
demonstrate how technology can benefit student learning.  The training, support
and encouragement that I offer should create teacher expertise and desire for
additional technology use.  The troubleshooting and technical support that I
provide should minimize the setbacks caused by equipment failure.  Although I
can�t prevent all obstacles, I must be a problem solver, a mentor, and a model,
who arranges the receipt of as many positive reinforcing cards as possible.  My
research into The Technology Game is an anecdotal record of how I have
attempted to identify the rules of the game, to support teachers and to reach our
stated goals.

Drawing Favorable Cards
Our game consists of many cards and many opportunities, either taken or

missed.  Lemon Road has already drawn many favorable cards.  First, we have a
visionary principal, who created the position of Technology Resource Teacher in
1996, four years before the county decided to fund such a position.

We were able to acquire donated computers, write grants to purchase
needed equipment, and find volunteers to create a working lab, network the
computers to a server and establish a system in which students could access their
work throughout the building.  We began reviewing and purchasing appropriate
software.  In 1998, our school was wired for the Internet and we established our
school Intranet to house resources related to curriculum needs.  In 2001 as a
�model technology� school, we received many new computers to equip a 30-
computer lab in addition to having 4 to 6 computers in each classroom.  With this
equipment came licenses for many software titles.  Our business partner, First
Virginia Bank, and our PTA donated substantial funds over the years to purchase a
color laser printer, scanners, a Smartboard, a portable multimedia center of 30
AlphaSmarts, a digital camera and many valuable software titles to support our
curriculum.

Rules of the Game
Before starting this research I didn�t have a clear image of our game.  I saw

many problems, equipment that kept breaking, teachers with no time to plan or
implement technology and SBTS duties that kept me busy updating inventory and
writing training plans that didn�t seem to work.  It was not until I began keeping a
journal of daily activities that a pattern began to emerge and answers to problems
began to surface.

I knew that I needed to present training that focused on curriculum and
specifically addressed the SOLs.  I planned �SOL Solutions� for after-school training.
I presented technology as a tool for addressing curriculum needs. I demonstrated
Mapmaker�s Tool Kit, Inspiration, and Kidspiration during after-school training
sessions.  The sessions were not well attended for various reasons.  Teachers
complained that lessons were after hours, they had other commitments and there
was never enough time.  When I presented training on Outlook, the Microsoft e-mail
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program, attitudes changed.  Teachers wanted to know how to communicate in
our new e-mail system.  I prepared handouts that introduced teachers to our
county Intranet site, answered questions and helped them set up their own folders
and distribution lists.    I believe that because teachers had an immediate need to
know the e-mail system they found a way to attend the training.  Other after-hours
training had not presented itself with the same urgency.  Yet the collaboration that
began with this training would continue to grow in other areas.

Modeling the Game Plan
I have always modeled classroom lessons for teachers.  While I am modeling

the lessons, teachers are observing more than just technology integration.  They are
observing new strategies for teaching, new opportunities to differentiate services
and new ways for students to demonstrate what they know.  As teachers watch
me, they become familiar with the software, see more potential for its use, and see
the enthusiasm that it generates for student learning.  As they gradually become
more comfortable using the programs, teachers are in a position to create their
own activities and take risks, knowing that I am there to support them.

Taking Turns
I find the scheduling of technology for 45 minutes a week whether students

need it or not an outrageous concept.  Technology should be used only when its
application is appropriate.  A once-a-week lab time is not well suited to integrating
technology into a lesson plan and may not recognize computers as tools to
support the curriculum. I have an on-line schedule on the server through which
teachers sign up their classes for lab time, or for my time, whenever they want.  This
accommodates the teacher who plans a lengthy project and wants more than one
block of time per week.  It allows teachers to select the resources they need and
the times that coordinate with the subjects being taught.  They may need the lab
several times a week for some weeks and then not again for a while.   The facilities
are available on a first come, first served basis whenever the teachers want them.

Planning Our Strategy
Our two sixth grade teachers were quick to request planning times.  In

October, we discussed curriculum objectives and I suggested technology projects
that might satisfy their needs.   During our planning, I mentioned that students need
to develop skills of on-line searching for relevant information.  Students need to
learn how to evaluate and validate the resources they find.  Once the resources are
selected, students must use information to create and refine their knowledge.  It is
the interaction of student and information that creates learning.  Using textbook
resources alone will not equip our students with skills needed in their future.  One
sixth grade teacher said she had never thought of that.  She was just beginning to
see reasons for technology integration.

For our next project, we planned the role of each teacher, designed student
directions and anticipated the timing.  Knowing our expectations, each student
would create his or her own Hyperstudio project. Students would use our Intranet
resources to research and take notes.  They would select relevant information and
they would create a final product based upon their use of the materials found.
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Students, not teachers, were responsible for learning.  Students were proud of their
resulting projects and eager to be evaluated using peer rubrics.  This was the kind of
technology integration that I hoped the whole school would eventually enjoy.
Ranging from the visual content of The Human Body CD, to diary writing following The
Oregon Trail cyber experience, to selecting a science project through our school�s
�Scientific Method of Investigation� website, these classrooms were never without
resources and project ideas.

Advancing Along the Board
A third grade teacher was also daring enough to create innovative

technology projects.  He came to me for instruction and advice, to see what could
be done and how best to accomplish his goals.  Using the digital camera to import
student pictures into Publisher, his students presented families with calendars as
winter holiday gifts.  He told his teammates of the activity so that everyone could
present calendars to their families. Next, he designed an Excel spreadsheet to
record, calculate and communicate student math concept development. He
could instantly see which students needed additional help in any particular area and
could differentiate services appropriately.   Students could update their own test
scores and records, and he was able to inform parents of student progress in a
timely manner.  Then he experimented with Hyperstudio and created a lesson in
which students would create an interactive dictionary.  He was becoming more
independent and taking risks, knowing that I would support him.  Each project
succeeded and created a desire to try another.  He is rapidly becoming a
technology-savvy teacher.

Three Steps Backward
By January, I expected all teachers to be using technology consistently. Yet, as

I walked the halls of our building, I saw too many classroom computers with the
screen saver disease, a disease in which only the screen saver is seen throughout
the day.  I was discouraged by what I interpreted as teacher apathy towards
technology and lack of effort to incorporate technology into curriculum objectives.
Too often, computers were seen as a reward for finished work or good behavior.
It was impossible for me to keep to a schedule because of the constant
interruptions or cancellations.  Teachers would come to me for help and
suggestions, but they wanted instant answers.  They wanted materials and
directions immediately and, of course, I couldn�t always comply.  I was offering
�SOL Solutions�, advising teachers who needed technology certification and
planning with some teachers.  In spite of my best efforts, many teachers were not
using our computers as I thought they should. Having the latest computer systems
did not insure appropriate use.  What was I doing wrong?   How could I encourage
more productive computer use?

Understanding the Rules
I posed my questions to the teacher-researcher group to which I belong.

They offered valuable suggestions.  Try attending team planning meetings and
discussing SOL objectives, they said.  Go to the teachers and initiate projects and
activities.  Work with the teachers who show interest and focus on the positive.  I
followed their advice and soon saw a totally different view of technology use at
Lemon Road.
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After our teacher research meeting, I was determined to return to school
and initiate a visible viable integration program.   I would become more proactive
and look for opportunities to include reluctant teachers in integrated technology
lessons.  I created a questionnaire in which I requested teacher opinions and needs.
By listening to their responses, I refocused my efforts.

I asked:I asked:I asked:I asked:I asked:
1. What are the most impor1. What are the most impor1. What are the most impor1. What are the most impor1. What are the most impor tant functions pertant functions pertant functions pertant functions pertant functions perforforforforformed by the SBTS inmed by the SBTS inmed by the SBTS inmed by the SBTS inmed by the SBTS in
our school?our school?our school?our school?our school?

The most frequent responses were troubleshooting, training on hardware and
software, finding and sharing new software, and planning integration activities

      Figure 1: SBTS functions as seen by teachers.      Figure 1: SBTS functions as seen by teachers.      Figure 1: SBTS functions as seen by teachers.      Figure 1: SBTS functions as seen by teachers.      Figure 1: SBTS functions as seen by teachers.

2. What SBTS activities have you found useful?2. What SBTS activities have you found useful?2. What SBTS activities have you found useful?2. What SBTS activities have you found useful?2. What SBTS activities have you found useful?
To my surprise, the top responses were after school training and initiating

integrated lab projects and activities.   Although I didn�t think the training had been
well attended, the teachers had appreciated the training offered.  The training with
immediate use such as the Outlook training was considered most valuable.
Teachers had not initiated lab projects but were eager to participate once I
offered them.  Here was a lesson to be learned.  If  I initiated the projects, the
teachers were happy to follow.  It appeared that without my support, teachers
lacked the confidence to create integrated technology lessons.  Especially after I
pointed out all the SOLs being covered with the projects, they were enthusiastically
received.
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                                   Figure 2: Useful SBTS activities identified by teachers.Figure 2: Useful SBTS activities identified by teachers.Figure 2: Useful SBTS activities identified by teachers.Figure 2: Useful SBTS activities identified by teachers.Figure 2: Useful SBTS activities identified by teachers.

3. What factors have encouraged you to use technology in your3. What factors have encouraged you to use technology in your3. What factors have encouraged you to use technology in your3. What factors have encouraged you to use technology in your3. What factors have encouraged you to use technology in your
classroom?classroom?classroom?classroom?classroom?

The most frequently stated factor encouraging teachers to participate in
technology integration was the belief that students want and need to know how to
use technology.  The second most often reported factor was knowing that I was
willing to help and support teachers as needed.  Other teachers mentioned use of
technology because of a diversity of student needs, a need to individualize
instruction, opportunity to plan at team meetings, and availability of good software.
I began to think there was a lot that was right with our program.

       Figure 3: F       Figure 3: F       Figure 3: F       Figure 3: F       Figure 3: Factors encouraging use of technologyactors encouraging use of technologyactors encouraging use of technologyactors encouraging use of technologyactors encouraging use of technology.....
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4. What are some of the factors that prevent you from integrating4. What are some of the factors that prevent you from integrating4. What are some of the factors that prevent you from integrating4. What are some of the factors that prevent you from integrating4. What are some of the factors that prevent you from integrating
technology in your curriculum?technology in your curriculum?technology in your curriculum?technology in your curriculum?technology in your curriculum?

The resounding answer was lack of time; time to plan and execute an
integrated lesson, time to become familiar with programs, time to search for
appropriate materials. To my surprise, one teacher mentioned our lack of software.
This told me that having software in our building was not sufficient.  I needed to do
more to let teachers know what was available.  I began creating �resource sheets�
on software to let teachers know what subjects and objectives the software
covered and how best to offer it to students.

        Figure 4: Deter        Figure 4: Deter        Figure 4: Deter        Figure 4: Deter        Figure 4: Deterrents to use technologyrents to use technologyrents to use technologyrents to use technologyrents to use technology.....

5. Do you consider the use of technology impor5. Do you consider the use of technology impor5. Do you consider the use of technology impor5. Do you consider the use of technology impor5. Do you consider the use of technology impor tant to thetant to thetant to thetant to thetant to the
classroom? Why?classroom? Why?classroom? Why?classroom? Why?classroom? Why?   Most teachers stated that students needed to develop
multimedia skills.  Others stated that technology accommodated learning styles,
created increased resources of information and it was fun.

        Figure 5: Impor        Figure 5: Impor        Figure 5: Impor        Figure 5: Impor        Figure 5: Importance of technology in the classroom.tance of technology in the classroom.tance of technology in the classroom.tance of technology in the classroom.tance of technology in the classroom.
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6. If I could change one thing about our program, I would�.6. If I could change one thing about our program, I would�.6. If I could change one thing about our program, I would�.6. If I could change one thing about our program, I would�.6. If I could change one thing about our program, I would�.
Teachers wanted more lab time, earlier lab openings, more direct student

teaching by SBTS and a weekly schedule in the lab.  This suggests to me that
teachers want computer use; they just hesitate to plan it by themselves.  My focus
needs to shift to greater initiation and planning of activities.

        Figure 6: T        Figure 6: T        Figure 6: T        Figure 6: T        Figure 6: Teacher desired improvements in technologyeacher desired improvements in technologyeacher desired improvements in technologyeacher desired improvements in technologyeacher desired improvements in technology
        program.        program.        program.        program.        program.

Clarifying the Rules
My request to attend team-planning meetings was enthusiastically received.

Discussions began with teachers stating the areas of curriculum to be covered.
Then I suggested computer projects that would support the objectives.  Teachers
would pick the suggestions that they liked and that fit their time frames.  We planned
so that each contributed their expertise to the developing lesson.  To my surprise,
teachers were very open to suggestions and willing to collaborate.  They supplied
nine-week plans and discussed which curriculum objectives were best achieved
with technology integration. We were working together to integrate technology into
the classroom curriculum.  A new collaborative energy was evident.  I began to
believe  that our students could be  prepared for the literacy demands of their
future.  For the first time, I really felt we were winning the technology game.

The continuation of this research will appear in the next VSTE Journal
publication.  My reflections have allowed me to identify several findings and
implications that will guide the future integration of technology in our building.  These
will be listed in my conclusion.

The Technology Game, continued
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W e fully understand the cognitive and aesthetic impact of a well-decorated
classroom in the physical world, but how does that knowledge transfer
into the virtual classroom?

As teachers, we mark our academic territory with our personal sense of style.
A splash of summer yellow to a mud-luscious frog dangling above desks help to
define both our teaching personality and our rich course content.  Recreating this
stamp of uniqueness in the cyber-world requires that we carefully consider the five
C�s of cyber decorating: comfort, content, cohesiveness, color, and clips.

Comfort
Our students� first online experience can be quite harrowing.  As online

course builders, we need to adorn our cyber-rooms with a warm and inviting
décor that encourages open and productive discussion.  Just as you hang a poster
on a wall of a physical classroom, the posters in our virtual cyber-rooms need to
reflect both positive and academic messages.

Course ambiance can also be created by the warmth of our words.  An
enthusiastic welcome should begin any course.  Either synchronous online
availability or asynchronous turn around response time should be clearly stated
within the welcome message.  For web-enhanced, flexnet or virtual courses, the
facilitator�s office hours and physical availability should be included.  When
introducing an online course, provide a chat room for students to practice an
online exchange.  You may wish to include an additional discussion forum that allows
students to ask questions directly to the course facilitator.

Words of encouragement should be peppered throughout the entire course.
Assignments and assessments should have clearly stated expectations with
deadlines repeated in numerous places.  Rubrics also help to support a high
degree of comfort.

Trading Spaces:
From the Classroom
to the Cyber-Room.
Interior Decorating for
the Virtual Course

by Sigrid Bomba and Jane Clark
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Adding to your students� comfort is the degree of ease with which they can
navigate through your particular platform.  If possible, documents and external links
should be organized into folders.  All course information should be organized in a
logical and user-friendly format.  Before course activation, soliciting feedback from
several students and an online peer should prove beneficial.

All courses should include a final survey.  In the final survey, questions regarding
ease of navigation, tone of the facilitator�s feedback, and the student�s comfort
level should be included.  The final survey is critical in determining the effectiveness
of the course, course builder, and facilitator.

White space surrounding the course text is dictated by the level of the
course.  For example, if the course is designed for a third grader, paragraph breaks
should be wider.  Also, the white space around the course title and text should
increase.  However, a college course would have an increased amount of text with
minimal white space.

Content
With all of the technological bells and whistles available today, we sometimes

lose sight of the fact that the course content drives the decorating embellishments
rather that the decorating driving the course content.  The bells and whistles must
enhance or clarify the content.  In other words, the content text and information
should be the focus of each page with the graphics taking a subordinate position.
Concept maps that accompany text allow the student a snapshot view of the
relationship between concepts (Kremer, 1). Assignments and directions should be
concise and directed specifically toward the intended audience (Kelley, 1). Small
movements or muted color change graphics should be placed above or below
the text.  This allows the reader to scroll the text into a position where the
animation cannot be viewed during text reading.  Animated graphics are fun, but
frequently deter from the content depending on the degree of animation.
Embedding animated graphics should be seriously considered.

Inspiration and Kidspiration software are the champions of content text
enhancements.  Research pertaining to learning effectiveness clearly states that
content information is more readily obtained and with greater depth when the
information is distributed in both a text and non-text (visual representation) mode
(Chase 1, 6-8).  This software allows the course builder to create simple and
complex graphic organizers with little time invested.  Both programs also contain a
conversion option where the graphic organizer can easily be converted to a
linguistic format.

Cohesiveness
Text and decorative embellishments equally contribute to the cohesiveness

of the course.  Fluency supports comprehension.  When our students stop to
decipher an unfamiliar word or a confusing graphic, the cognitive process is
interrupted.  Regaining focus is difficult, but when reading fluency is repeatedly
interrupted, comprehension seriously deteriorates.
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Fonts for titles and subheadings can be selected from any number of serif and
san serif fonts as long as they are easily readable. �Fun� fonts help to lighten a heavy
academic tone and can be enhanced by adding color.   These �fun� fonts should
only be used for titles and subheadings.  For the bulk of the content text, select a
serif font.  Newspapers, textbooks, and magazines all use serif fonts for good
reason.  The serif font adds clarity to each letter and, thus, contributes to visual
fluency.

Color
Decisions concerning color should be made after the course text has been

written. As previously stated, the decorating should be subordinate to the course
content and, therefore, color and decorating decisions can be made after the
course has been written.   Course colors can be divided into two main categories:
the masthead and the content pages.  For best results, choose one dominate and
one accent color.  Certainly this does not exclude other coordinating colors, but
consistency of color supports the fluency of the content text.  Using too many
colors, clashing colors, all dark colors or all milky light colors will interrupt the visual
flow of the course and, therefore, hinder comprehension.

After the course builder clearly identifies the target audience, viewing a
complete color palette will provide a spectrum with which he or she can �play�
with color choices.  From the palette, first decide on a color grouping such as
primary or pastels.  Younger children are attracted to the primary colors. A barn-
red wagon with a kelly green tree are common graphic colors associated with
emergent and beginning readers.  Older audiences provide a wider opportunity
for choosing colors.  If your audience is predominately young adults, a choice of
bright trendy colors may be appropriate.  Currently, that choice would include the
neon colors.  A lime green with a purple accent would be especially appealing to
the teen and preteen audience.  Usually, courses designed for the adult are
lengthier.  Here, you can vary your color choices within the weekly assignment.  One
week�s assignment may have an Earth tone theme, while the next week may be a
textured theme.

Most online courses contain a masthead or banner that the student sees
upon entering the course.  The colors chosen for the masthead should be the
anchor colors for the remainder of any short course.

Using color to alert the student to specific text is also effective.  For attention
grabbers, use opposite colors on the color wheel (i.e. yellow and purple, orange
and blue, etc.).  The opposite color may be used no matter what color theme you
have chosen as your dominate and subordinate colors.   An upcoming quiz or a
homework reminder using orange in lieu of the traditional black helps to direct the
reader�s attention. A constant color associated with a particular content concept
will enhance the student�s comprehension.  For example, in an Earth Science
course, the course builder may use the color blue for all concepts or vocabulary
words relating to water or the color brown for all newly posted materials and the
color red for project assignments.
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Clips
Clips include any graphic material imported into the course such as graphic

organizers, maps, photographs, video, diagrams, and picture clips.  Informational
clips should directly correspond to the text with clearly identifiable labels,
drawings, and font.  The size of the clip is relative to the size of the text.  A single line
of text does not warrant a four-inch clip, whereas a large body of six-inch text may
be enhanced by a one-inch graphic.  If the clip is a diagram that clearly is the focus
of the content, then the size should be significantly increased.  Keep in mind that
large clip files will increase downloading time.  Diagrams, maps, and other
informational clips should be crisp.  Using tools such as shadow fonts or frayed
edges for creating informational clips deter from comprehension.  Using too many
clips within one page can also lead to reader confusion and points the attention of
the student to the graphics rather than the course content.  Likewise, animated clips
are both eye-catching and fun, but the unnecessary motion detracts from the
content.

Within a weekly assignment, graphics that depict similar characteristics should
be consistently used throughout the assignment. Examples of similar theme graphics
are below.

Graphic theme for a younger audienceGraphic theme for a younger audienceGraphic theme for a younger audienceGraphic theme for a younger audienceGraphic theme for a younger audience

Graphic theme for an older audienceGraphic theme for an older audienceGraphic theme for an older audienceGraphic theme for an older audienceGraphic theme for an older audience

Inserting video clips certainly adds to visual and content enrichment.  All
video clips should be accompanied by expository captions.  The course builder
should clearly state a purpose for the clip and give the student a specific
assignment relating to the clip.  An example of a video caption is below.

The clip above highlights several turning points during the Civil Rights Movement.  As
you view the clip, record these events and think about how they contributed to
the overall success of the movement.

Video Clip
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Notice that the reader has been provided with the topic of the clip, the
purpose for viewing the clip, and a prompt for further content synthesis.

Younger students enjoy cartoon-type figures that represent children of their
own age.  Photographs and more complex graphics can be used in adult and
young adult courses.  Figures should be engaged in activities described within the
text and represent ethnic as well as gender diversity.

Audio clips greatly enhance courses such as foreign language and speech
courses.  Musical clips, when paired with video, contribute to the aesthetic appeal
of the content.  Using musical clips without video is not recommended.

The music, unless directly related to the content (example: music written
during the Civil War in a history course), will distract the reader.

Using the mantra of the design world, form follows function, you will find that
the decorating possibilities are endless.  Discovering your own particular style within
the course contributes to a feeling of success for your students.  The placement of
furniture within a physical classroom rarely changes throughout the school year.
Students know where to sit, know the location of the computer lab, and know
where the teacher can be found.  Your cyber-room is much like the physical
classroom in that the students need a comfortable routine for locating information.
They know where information will be because it is consistent.  They know that
certain colors indicate certain activities.  And they know they will be safe and
secure in the warm and inviting environment that you have so thoughtfully created.

� Microsoft Clip Art and Media: http://dgl.microsoft.com

� Free Clip Art Kingdom: http://www.clipartcastle.com

� Barry�s Clip Art: http://www.Barrysclipart.com

� Tech4Learning: http://www.tech4learning.com

� Clip-Art.com: http://www.clip-art.com

� Discovery�s School Clip Art Gallery: http://school.discovery.com/clipart/

Article Resource URLs
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W

Best Practices
for Using Microsoft
Word to Create
Simple Web Pages

eb development applications like Microsoft FrontPage, Macromedia
Dreamweaver, and Adobe GoLive expedite the process of creating and

editing web pages. These and other programs have become increasingly more
popular and more powerful in their capabilities. However, despite readily available
training and a reasonably gentle learning curve, many educators are still hesitant to
venture into web page design. Perhaps part of the reason is due to the mystique
related to HTML and confusion surrounding the many technologies that intersect in
bringing us the Internet. For users reluctant to venture into web development,
Microsoft Word can be a viable option for someone just beginning to develop
web pages.
 

Microsoft Word has essentially become the standard word processing
application and for good reason; it�s an excellent, general-purpose application for
creating a variety of documents. With the increasing popularity of the Internet,
Microsoft has made progress over time in integrating Word and the other Microsoft
Office applications with the web. By utilizing Microsoft Word, those seeking to
develop simple web pages can begin with a tool and application interface with
which they are already familiar. By following some best practices, perhaps forgetting
a few bad habits, and using various utilities to cleanup the extraneous HTML code
that Word generates, the average user can create simple, static web pages that are
acceptable. However, for more dynamic documents that feature interactive
elements or more sophisticated page layouts, a web development tool like
Macromedia Dreamweaver would be needed.

 
Those using Word for web page development will need to use Word with the

mindset that the ultimate product will be a web page. Web documents are written
in HTML, or Hypertext Markup Language, a document language that defines the
structure and layout of a web document by using a variety of tags and attributes.
While learning how to write HTML code is not necessary for creating web pages, it
is important to understand that there are certain constraints imposed by HTML, and
a user cannot do everything he or she may be accustomed to doing in using the
word processor. Because of the nature of how HTML displays web pages, those
using Word in creating a web page will recognize that there are special ways to
format the content in a document that might be different from what they are
accustomed to doing.
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Simple Web Pages, continued

Getting Started
In beginning a new document, you can either start with a document in Word

format, or an HTML document. Selecting File > NewFile > NewFile > NewFile > NewFile > New opens the window you see
in the screen capture below:

   Figure 1:  C   Figure 1:  C   Figure 1:  C   Figure 1:  C   Figure 1:  Create new documentreate new documentreate new documentreate new documentreate new document

If you know from the start that your document will essentially be a web page
that will not be printed or saved as an Adobe PDF file, it makes sense to begin with
a new Web Page. However, for documents that will likely be printed out, it�s
important to realize that it�s often difficult to print out a web page because you
can�t use page breaks to lay out the pages, and the pages often break in
undesirable places within the document. Therefore, choosing to begin with a blank
Word document is often your best option, provided that you follow best
practices in creating your document, with the understanding that the ultimate
product will be a web page.

There are three layouts that you can select when composing a document in
Microsoft Word: Normal, Web Layout, and Print Layout. To change your screen
layout, use the View menu. When using Word to create a web page, it is best to
work in Web Layout mode, although occasionally you should switch to the other
modes to check the appearance of your document, especially if it will be printed.
Note that in Web Layout view, the margins are close to the edge of the page. When
you�re in Web Layout, the ruler should be removed from the toolbar. The width of
text on your page is dependent upon browser and display settings on the
computer that you are using to view your page. Therefore, having the ruler present
in Web Layout would serve no purpose when creating your web page. To remove
the ruler, go to your View menu and uncheck Ruler.

Forgetting Bad Typing Habits
 OK, now don�t get too defensive. The first step is to honestly look at how

you typically use a word processor. There are several bad habits that will cause
trouble in creating web pages. You may get away with these bad habits in typing
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Simple Web Pages, continued

word processing documents, but this will not be the case in creating web pages!

TTTTTab kab kab kab kab keyeyeyeyey: : : : : Please forget that your keyboard has a Tab key!
                                                                                           
Outside of using it to move from one cell or field to another in a table, form,

or spreadsheet, it has virtually no other purpose in creating a web page document.
Do not use the Tab key to indent paragraphs because HTML clean-up utilities, like
the one included with Dreamweaver, will remove indentation created with the Tab
key.

Formatting Paragraphs
If you need to indent your paragraphs, then use Word�s paragraph formatting

feature. Select FormatFormatFormatFormatFormat >  >  >  >  > ParagraphParagraphParagraphParagraphParagraph, and the window like you see on the right will
open. Open the drop-down list under SpecialSpecialSpecialSpecialSpecial to select First lineFirst lineFirst lineFirst lineFirst line     to indent your
paragraph. Indenting your paragraphs this way will insure that your HTML code will
indent your paragraphs using the text-indent property that is a feature of the
Cascading Style Sheet standard.

         Figure 2:  Paragraph window         Figure 2:  Paragraph window         Figure 2:  Paragraph window         Figure 2:  Paragraph window         Figure 2:  Paragraph window
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Simple Web Pages, continued

Inappropriate use of the Spacebar
Inappropriate use of the Space Bar can get you into trouble when creating

documents destined for the web:  
� Don�t use the Spacebar to indent paragraphs; indent your paragraphs

using the paragraph formatting method described above.

� Never use the Spacebar for aligning text or graphics on the page. Use the
Center tool to center text or images, and use the Increase Indent or the
Decrease Indent to indent entire paragraphs or a list of items. If three page
elements need to be spaced across a page, even on a single line, the user
needs to follow best practice and create a three-column tabletabletabletabletable.  

Inappropriate use of the Enter key
The Return or Enter key can also get you into trouble:

� Very few users are actually guilty of this, but don�t hit the Enter key at the
end of each line like you�re using a typewriter. The Enter key should only be
struck once at the end of each paragraph, unless you are creating a
bulleted or ordered list or inserting blank lines on a page. Allow the lines in
a paragraph to automatically wrap from one line to the next.

� Do not hit the Enter key several times to force text to start on a new page.
Inserting a page break for this purpose will allow you to print your
document the way you desire, without causing your document to look
awful in a web browser because of the extra spaces.

Formatting Issues
Selection of fontsSelection of fontsSelection of fontsSelection of fontsSelection of fonts

  You should use fonts that are common to both the Windows and Macintosh
platforms, and which will be installed on the majority of computers that will be
browsing your web pages. If someone views your page and his or her computer
does not have the font installed, your page will be displayed using the browser�s
default font, which is typically Times New Roman. There are basically two major
types of fonts: serif fontsserif fontsserif fontsserif fontsserif fonts, in which the letters have little serifs or embellishments on
the edge of the type, and sans serif fontssans serif fontssans serif fontssans serif fontssans serif fonts that are simpler and lack the serifs.
Generally speaking, in printed documents, serif fonts are often used for the main
body of text in order to aid in reading and the recognition of characters because
the little serifs help to guide our eyes and our brain, while sans serif fonts are often
used for headings. However, on a computer screen, many people believe that sans
serif fonts are easier to read because serifs tend to disappear on the screen,
especially with small type. The sans serif font Arial is a popular font used for web
pages. Some serif style fonts like Courier NewCourier NewCourier NewCourier NewCourier New are mono-spaced fonts where
spacing is not adjusted to accommodate letters of different sizes (typewriter style
fonts).

 
Regardless of which fonts you use, a general principle for most situations is the

rule that you should never use more than two fonts on the same pageyou should never use more than two fonts on the same pageyou should never use more than two fonts on the same pageyou should never use more than two fonts on the same pageyou should never use more than two fonts on the same page.
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Simple Web Pages, continued

Using too many fonts on a page can be a bit of an eyesore. The text of this article,
for example, is sans serif. While the safest fonts to use are probably Times New
Roman and Arial, there are other fonts that are a relatively safe bet, and which will
be found on most computers. The following table lists fonts that are good for web
pages:

  Figure   Figure   Figure   Figure   Figure 3: F3: F3: F3: F3: Font charont charont charont charont char ttttt

Use Styles
Often, those using Microsoft Word for

word processing will spend a lot of time
highlighting text throughout a document and
manually changing the font and font size over
and over again. There is a better way. Using
StylesStylesStylesStylesStyles allows you to quickly format a
document in such a way that you�re
consistently applying the same font
attributes throughout the document. For
example, let�s assume you want certain sub-
headings to all be the same font and size, in
bold text. Rather than manually having to
make these three changes repeatedly for
each sub-heading, you can use Styles to
simply the process. For example, the title at
the top of a page might be set for Heading
2, section headings might be Heading 4,
while the main body of text is Normal text.

Not only does using Styles save time
and labor for general word processing, but
using Styles is also important for documents
that will later become web pages. When a
document that uses Styles is saved to HTML,
Word will save your document using the
HTML heading tags such as H1, H2 and so
forth. To use the Paragraph styles in Word,
highlight your paragraph or text, and select
Format > StyleFormat > StyleFormat > StyleFormat > StyleFormat > Style, or use the drop-down list
on the Formatting toolbar.

Figure 4: Style selectorFigure 4: Style selectorFigure 4: Style selectorFigure 4: Style selectorFigure 4: Style selector
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Use Bulleted and Numbered Lists and
Decrease and Increase Indent

Use automatically formatted bulleted and numbered lists for both
documents in Word format, as well as web pages. Note that if you start trying to
type a list manually by beginning the first line with 1. (number 1 followed by a
period) and then a space, Word automatically converts your text to a numbered
list. Automatically formatted lists format well when saved in HTML.

Please note what was emphasized above under the sections relating to
inappropriate use of the Tab key and Space Bar. If you want an unordered list
without bullets, then you can type your list of items, highlight the text and use
Decrease Indent or Increase Indent to indent the list of items. If you want a bulleted
list, then simply type your list, highlight the text and create a bulleted list.

When creating bulleted lists, don�t try to get too fancy with the style of your
bullet. Using customized bullet styles relies typically upon the Wingdings font, so that
the computer being used to view your page must have Wingdings installed
(however, most computers will have Wingdings installed).

Use Tables!
Tables are an excellent tool for organizing and displaying information in rows

and columns. As mentioned earlier in the section relating to inappropriate use of
the Tab key, the practice of
typing and using the Tab key
to manually move over a set
amount of space for each
column is not best practice
(unless you�re using an old
typewriter that you happen
to pick up from an antique
store).

Those creating web
pages must become
proficient with tables
because web page layout is
typically highly dependent
upon effective use of tables.
Word provides you with
some decent tools for
creating tables. There are
generally two main ways to
create tables in Word:

Use the Use the Use the Use the Use the TTTTTableableableableable menu to inser menu to inser menu to inser menu to inser menu to inser t a tablet a tablet a tablet a tablet a table
You can select TTTTTable > Inserable > Inserable > Inserable > Inserable > Insert > Tt > Tt > Tt > Tt > Tableableableableable to create a table and specify the

number of columns and rows.
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Draw Tables
You can draw a

table using the Tables
and Borders button on
the Standard toolbar.

While drawing
tables is an easy way
to create tables, there is a serious drawback if you�re creating tables for a web
page with this method. When you draw tables, Word, of course, creates a table
with the exact dimensions that you drew. However, tables that are drawn do not
automatically scale very well in the web browser to suit different display settings.  In
most cases it is best NOT to draw tables, or even overly �tweak� the height of rows
or the width of columns. While sometimes you will need to adjust the height of rows
or the width of columns, leaving these settings undetermined will allow a table to
automatically scale to suit different display settings and whatever content is placed
in the table. Therefore, our focus will be on using the Table menu to create tables
and on becoming proficient with ways to customize tables and edit their
properties.

Table Properties
After

you create
your table,
it is easy to
adjust the
properties
of the table.
Place your
cursor
anywhere
within the
table, and
select Table
> Table
Properties.
The best
way to learn
how to
create
tables is just
to do it.
Create a
practice
document
and
experiment

Simple Web Pages, continued

Figure 6: TFigure 6: TFigure 6: TFigure 6: TFigure 6: Table draw toolbarable draw toolbarable draw toolbarable draw toolbarable draw toolbar

Figure 7: TFigure 7: TFigure 7: TFigure 7: TFigure 7: Table properable properable properable properable proper ties (table tab)ties (table tab)ties (table tab)ties (table tab)ties (table tab)
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with creating different tables and changing properties. In the screen capture on the
right, notice you can change the properties of the table as a whole, or the
properties for a row, column, or even an individual cell.

Changing Cell Properties
Knowing how to change the Vertical Alignment of a cell is something that will

be useful in formatting your table. In this particular cell, the vertical alignment is set so
that the text starts at the top of the column.

          Figure 8: TFigure 8: TFigure 8: TFigure 8: TFigure 8: Table properable properable properable properable properties (cell tab)ties (cell tab)ties (cell tab)ties (cell tab)ties (cell tab)

Using Horizontal Lines
To add a horizontal line to your document, select FFFFFororororormat > Borders andmat > Borders andmat > Borders andmat > Borders andmat > Borders and

ShadingShadingShadingShadingShading, and then click on the button on the Borders tab.

This opens the Horizontal Line window, seen in the screen capture. Please
note that all of the options on the PicturesPicturesPicturesPicturesPictures tab use images for the horizontal lines,
except for the first option. Choosing the first option allows you to create a
horizontal line without adding additional download time to your document
because Word takes advantage of the horizontal rule <HR> tag in HTML for this
particular option.

Simple Web Pages, continued
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        Figure 9: Horizontal line window        Figure 9: Horizontal line window        Figure 9: Horizontal line window        Figure 9: Horizontal line window        Figure 9: Horizontal line window

Inserting Image Files
Pictures FPictures FPictures FPictures FPictures From Filerom Filerom Filerom Filerom File

There are several ways to add images to your documents in Microsoft Word.
You may have existing image files that you�d like to add, in which case you simply
select InserInserInserInserInsert > Picture > Ft > Picture > Ft > Picture > Ft > Picture > Ft > Picture > From File rom File rom File rom File rom File and browse to the location on your drive
where the file is stored,
and then select the file
and click on the Insert
button.

When you later
save your page in HTML
format, you�ll need to
remember to copy both
your web page file as well
as image files when you
copy the page to
another drive, computer,
or web server.

Simple Web Pages, continued

 Figure 10: Inser Figure 10: Inser Figure 10: Inser Figure 10: Inser Figure 10: Inser t pic windowt pic windowt pic windowt pic windowt pic window
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Copy and pasting images
Virtually any image that you copy to the Windows clipboard can be pasted

into your Word document. When you later save your document in HTML format,
Word creates a special folder for image files and assigns a file name to each of the
individual images on the page. For example, this particular document was saved
using the file name word_for_web_pages.htm, and Word automatically created a
folder entitled word_for_web_pages_files to house the images that are
embedded in the document.

Using the Microsoft Clip Art Gallery
You can also use the Microsoft Clip Art Gallery to add images to your page,

by selecting InserInserInserInserInsert > Picture > Clip Art > Picture > Clip Art > Picture > Clip Art > Picture > Clip Art > Picture > Clip Arttttt. The gallery features a search function
that works very effectively. For example, assume you were searching for an image
to accompany a hyperlink that you�re providing for visitors, so they can contact
you by e-mail. Depending upon how many images are installed on a particular
computer, using the search function to search for the keyword �e-mail� or �mail� will
probably find several images of envelopes or mailboxes.

Saving Your Document and the Microsoft
Office 2000 HTML Filter

The first section in this document, Getting Started, discussed that in beginning
a new word processing document you can either start with a document in Word
format or an HTML document.  If you opt to create a document in Word format, it is
easy to convert your document to HTML format. Simply choose File > Save AsFile > Save AsFile > Save AsFile > Save AsFile > Save As
and open the drop-down list for Save as type. Choose Web Page for the file type,
as seen in the following screen capture.

            Figure 11: Save as window with .html highlightedFigure 11: Save as window with .html highlightedFigure 11: Save as window with .html highlightedFigure 11: Save as window with .html highlightedFigure 11: Save as window with .html highlighted

DO NOT include any spaces in the file names of web pages or accompanying
image files. You can use an underscore to separate parts of a file name, but do not
use spaces.

If you save a Microsoft Word document in HTML and examine the source
code generated by Word, you will notice that there are special Office-specific
markup tags embedded in the code. These tags are designed to assist with the
�round-trip� of a document from HTML format back to Word format. Before
beginning to create word documents with Office 2000, it is recommended that
you download and install the Microsoft Office 2000 HTML filter, available on
Microsoft�s web site: http://office.microsoft.com/downloads/2000/Msohtmf2.aspx

Simple Web Pages, continued
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This special filter is free, and it allows you to save your document and remove
the Office-specific tags. Removing these Office tags from the code makes your
document more compact and more HTML compliant, and you reduce the file size
of a document, thereby saving on storage space on your hard drive or web server.
The Office 2000 HTML filter also adds the Copy as HTMLCopy as HTMLCopy as HTMLCopy as HTMLCopy as HTML feature as on option
under the Edit menu.

Using the Office 2000 HTML Filter
To export a document using the Microsoft Office 2000 HTML filter, simply

choose File > ExporFile > ExporFile > ExporFile > ExporFile > Export Tt Tt Tt Tt Tooooo and choose Compact HTML.

            Figure Figure Figure Figure Figure 12: Expor12: Expor12: Expor12: Expor12: Export tot tot tot tot to

Microsoft Word and Macromedia
Dreamweaver

While the Microsoft Office 2000 HTML Filter does a pretty good job of
cleaning up Office-specific HTML code , the professional web development
product
Macromedia
Dreamweaver
includes a similar
utility that
performs much
the same
function. After
opening
Dreamweaver,
select File >File >File >File >File >
ImporImporImporImporImpor t >t >t >t >t >
WWWWWord HTMLord HTMLord HTMLord HTMLord HTML
and browse to
select and open
your Word
document.
Dreamweaver�s
import utility

Simple Web Pages, continued

    Figure 13: Clean up word HTML    Figure 13: Clean up word HTML    Figure 13: Clean up word HTML    Figure 13: Clean up word HTML    Figure 13: Clean up word HTML
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opens a window that allows you to choose the version of Microsoft Word for the
document and the specific items that you�d like to clean up.

Experiment with Macromedia Dreamweaver and you�ll quickly see that the
application provides a treasury of features and advanced capabilities far beyond
what Microsoft Word offers for web development.

However, for simple web pages, Microsoft Word can be a viable option for
someone just getting started. By using the tool with the mindset and requisite skills
that the ultimate product will be a web page, you will find that Microsoft Word will
allow you to create simple web pages that are nicely formatted.

� Convert Word to HTML with Minimal Baggage!
http://www.delta.edu/emptrain/bookworm/word2html.html

� Converting Word Files to HTML
http://web.pdx.edu/~bowersn/basics/word_to_html.html

� Converting Word to HTML
http://www.yale.edu/instruct/web/html_info/word_to_html.htm

� Word 2000 Tutorial
http://www.fgcu.edu/support/office2000/word/web.html

� Building a Web Page with Microsoft Word 97
http://html.miningco.com/library/beginning/bl_begin070399.htm

Mark D. Webster is a specialist for Instructional and Information Technology
at the Mathematics & Science Center in Richmond, Va. He can be reached
at: mwebster@mathscience.k12.va.us.
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